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A

Valluru,

Date: 05-01-2021
To

Dr.P.Surendra Kumar,

Associate Professor, Bapatla Engineering College,
Bapatla.

Dear Sir,

Subject: Inviting for Certificate program “Antenna Design using HFSS”- Reg.

Greetings from RISE Krishna Sai Gandhi Group of Institutions, Ongole

As per the discussion with Dr.K.V.Subrahmanyam , Principal, of our Institute, I hereby

take this opportunity to invite you to conduct the Certificate program on Antenna Design using
HFSS ¢ From 02-02-2021 to 06-02-2021.

You are requested to interact and provide guidance to our IV B.Tech students, who are
looking forward to their bright career ahead. I will feel honored by your gracious presence at our

organization. 1 believe that your lecture will help our students and faculty members to explore
knowledge.

Thanking you in anticipation.

Yours sincerely,

o .
NDH



Dr. P. Surendrakumar

Associate Professor

ECE

Bapatla Engineering College, Bapatla.
Email: mailme_surendranitk@yahoo.co.in

Biography

Dr. P. Surendra Kumar, received his B.Tech degree from V.R. Siddhardha Engineering College,
Vijayawada and M.Tech in Digital Electronics and Advanced communications (DEAC) from
National Institute of Technology (NIT) Surathkal Karnataka in the Department of Electronics and
Communication Engineering, received Ph.D. in Microstrip antenna design from Nagarjuna
University, Guntur, (AP) He has 15 years of teaching experience as an Associate professor in
Bapatla Engineering College, Bapatla. His areas of interests are Microstrip Antenna design, MIMO
antenna and antenna design for 5G and 6G wireless applications. He has published 30+ research
papers in top journals and conferences.

Awards & Honors
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2
3
4
5
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Received 1% Best Research paper award from IEEE Hyderabad section (InCAP2018).

. Received 3'9 Best Research paper award from [1Sc Bangalore, INDICON2016.
. Received Best Young Researcher Award from Global Education (GECL2k19).
. Nominated for Young Scientist Award-2018 from innovative research developers.

. Reviewer for SCI Journal (International Journal of RF and Microwave Computer-Aided

Engineering, John Wiley & Sons Periodicals, Impact factor:1.306).

. Published research papers in IISc Bangalore, IIT Roorkee and IIT Bhubaneswar.
. Published IEEE SCI journal research papers in I[EEE Antennas and Propagation.

Reviewer for IEEE International Conference.

. Received UGC Minor research project of worth 2.3 Lakhs.

10. Reviewer for IEEE Access.

Selected Publications: latest 5 publications

Jé

P. Surendrakumar, “Miniaturization of patch antenna using partially loaded non-uniform
meta-surfaces with metamaterial,” IEEE Antennas and Propagation Magazine, Vol.61,
Issue. 01, Feb 2019.

P. Surendrakumar, “Design of Triple Frequency Vertex Feed Pentagonal slot antenna with
E-slot for WiMAX and WLAN Applications,” IEEE Antennas and Propagation
Magazine, Vol.60, Issue. 03, June2018.

P. Surendrakumar, Triple-UWB Millimeter-wave MIMO Antenna with Improved
Isolation for 5G Wireless Applications, IEEE Indian conference on Antennas and
Propagation 2019, Dec21.

P. Surendrakumar, A Compact Hexa-Band and UWB Antenna Using Heptagon and
Nonagon Rings with Vertex Feed, JEEE Indian Conference on Antennas and
Propagation, Dec 2018.

. P. Surendrakumar, “Design of a Miniaturized triple-band antenna with conductor backed

metasurfaces CPW-fed for SG Wireless applicationgs? council hosted by an
IEEE section, IEEE Bangalore, Dec 2017. B
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PROPOSAL FORM

SUB: Certificate program.

TO THE SECRETARY/CORRESPONDENT THROUGH PRINCIPAL FOR KIND

APPROVAL
1 NAME OF THE INSTITUTION Rise Krishna Sai Gandhi Group of Institutions
) NAME OF THE DEPARTMENT Electronics & Communication Engineering
3 | TITLE OF THE PROGRAMME Certiicatejprogram
4 NAME OF THE PROGRAMME Certificate program on “ Antenna Design using
HFSS”
S OBJECTIVE OF THE PROGRAMME | To bring the exposure in the Antenna Design.
Dr.P.Surendra Kumar,
6 DETAILS OF RESOURCE Associate Professor, Bapatla Engineering College,
PERSON(S)& CV ATTACHED. Bapatla.
7 PROPOSED DATE(S)/ACADEMIC 02-02-2021 to 06-02-2021
YEAR
8 DURATION OF THE PROGRAMME | FIVE DAY
9 VENUE MPMC Lab
10 | TARGETS IV ECE students
11 No. OF PARTICIPANTS 111 Students
12 | REGISTRATION FEE Eree
NAME OF PROGRAMME CO .
13 ORDINATOR(S) Mr. R.V Kiran Kumar
14 NAME OF THE STUDENTS 1.Ms. Nutha 'pati Thriveni ( 178B1A0430)
COORDINATOR(S) 2.Mr. Shaik'Baji ( 178B1A04B4)
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15 SOURCE OF FUND IDENTIFIED Management
16 MANAGEMENT CONTRIBUTION YES
REQUIRED
17 PROPOSAL PREPARED BY Mr. R.V.Kiran Kumar (CO-ORDINATOR)
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Coordpator S N % =
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)

Valluruy,
Date: 29-01-2021.

CIRCULAR

This is to inform IV B.Tech students and faculty that there will be a 5-Day Certificate
program on“Antenna Design using HFSS”from 02-02-2021 to 06-02-2021 by Dr.P.Surendra

Kumar, Associate Professor, Bapatla Engineering College,Bapatla.

SVMM
HOD s

HEAD OF THE DEPARTMENT
CE

Cop y to: Department of E

. RISE Krishna Sai Gandhi Group
Rrincipel of Institutions VALLURU,A.P.-523 272
Staff Circular
Students of ECE IV year

ECE Department Notice Boards
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NH-16, Valluru, Ongole, Prakasam (District)-523272
Department of Electronics and Communication Engineering

Certificate Program on “Antenna Design using HFSS”

Date: 02™to 06™Feb 2021

SCHEDULE FROM 02-02-2021 TO 06-02-2021

S. No Program List Timing
From To
DAY - 01 (02-02-2021)
1 Program started 09.00 AM --
2 Lamp lighting 09.00 AM 09.10 AM
3 Principal speech 09.10 AM 09.25 AM
4 HOD Introduction about Antenna Design 09.25 AM 09.35 AM
5 Tea Break 09.35 AM 10.00 AM
6 Introduction to Antennas 10.00 AM 01.00 PM
7 Lunch Break 01.00 PM 01.45 PM
8 Antenna Architecture 01.45PM 05.00 PM
DAY - 02 (03-02-2021)
9 Introduction to HFSS 09.00 AM 12.15PM
10 | Lunch Break 12.15 PM 01.00 PM
11 | Antenna Parameters 01.00 PM 05.00 PM
DAY - 03 (04-02-2021)
12 | Importance of HFSS with other tools 09.00 AM 12.15 PM
13 | Lunch Break 12.15 PM 01.00 PM
14 | Antenna Designing Mathematical 01.00 PM 05.00 PM
Calculations
DAY - 04 (05-02-2021)
15 | Antenna Designing Procedures 09.00 AM 12.15 PM
16 | Lunch Break 12.15 PM 01.00 PM
17 | Di-Pole Antenna Design in HFSS 01.00 PM 05.00 PM
DAY - 05 (06-02-2021)
18 | Result Analysis 09.00 AM 12.15 PM
19 | Lunch Break 12.15 PM 01.00 PM
20 | Some Sample Antenna Designs 01.00 PM 04.15PM
21 | Certificate Program Exam 04.15 PM 04.45 PM
22 | Vote of Thanks 04.45 PM 05.00 PM




Student Feedback Form

Name of the Student: [< « mn‘lsha

Roll No ‘18 BIAOLYLY
Topic : Certificate Program on '"Antenna Design using HFSS"

s

RISE KRISHNA SAI GANDHI GROUP OF INSTITUTIONS:: ONGOLE
DEPARTMEN1 7ELECTRONICS AND COMMUNICATION ENGIM  RING

Date: 06-02-2021

=

S.No Feedback Points 5 4 3 2 1
1 |Is the certification program useful or not ? v
2 [Is the certification program well planned or not? v
3 |Lecture makes objectives clear? v
4 |Lecture speaks clearly and audibly? e
5 |Lecture explains with exaples clearly? s
6 |Is you are doubts clarified or not? il
5-Excellent 4-Good 3-Average  2-Poor 1- No comment
K Mol
Student Signature
il
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RISE KRISHNA SAI GANDHI GROUP OF INSTITUTIONS:: ONGOLE
DEPARTMENT OF ELECTRONICS AND COMMUNICATION ENGINEERING

Student Feedback Form

Name of the Student: [{XBM Y
Roll No L $8R) m‘gﬁin
Topic : Certificate Program on ""Antenna Design using HFSS" Date: 06-02-2021
S.No Feedback Points 5 4 3 2 1

1 |Is the certification program useful or not ? v

2 |Is the certification program well planned or not? e

3 |Lecture makes objectives clear? v

4 |Lecture speaks clearly and audibly? v

5 |Lecture explains with exaples clearly? v’

6 |Is you are doubts clarified or not? d
5-Excellent 4-Good 3-Average  2-Poor 1- No comment
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Student Feedback Form

Namec of the Student: M. anfint
Roll No LAZRIPOY 96
Topic : Certificate Program on "Antenna Design using HFSS" Date: 06-02-2021
S.No Feedback Points 5 4 3 2 1

1 |Is the certification program useful or not ? v~

2 |Is the certification program well planned or not? v’

3 |Lecture makes objectives clear? v’

4 |Lecture speaks clearly and audibly? v

5 |Lecture explains with exaples clearly? =

6 |Is you are doubts clarified or not? v~
5-Excellent 4-Good 3-Average  2-Poor 1- No comment

L)

A
Stiflent Signature
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DEPARTMENT OF ELECTRONICS AND COMMUNICATION F: TINEERING

Student Feedback Form

Name of the Student: £ N&ga [fllC.Slﬁml
Roll No R P L SBIQOU—BL’
Topic : Certificate Program on '""Antenna Design using HFSS" Date: 06-02-2021
S.No Feedback Points 5 4 3 2 1

1 |Is the certification program useful or not ? e

2 |Is the certification program well planned or not? v

3 |Lecture makes objectives clear? ~

4 |Lecture speaks clearly and audibly? /

5 [|Lecture explains with exaples clearly? v

6 |lIs you arc doubts clarificd or not? e
5-Excellent 4-Good 3-Average  2-Poor 1- No comnent
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RISE KRISHNA SAT GANDHI GROUP OF INSTITUTIONS:: ONGOLE

DEPARTMENT OF ELECTRONICS AND COMMUNICATION ENGINEERING
CERTIFICATE PROGRAM FEEDBACK ANALYSIS

Year: IV B.Tech ECE

Name of the Certificate Program: Antenna Design using HFSS

Date: 06-02-2021

S.No

Roll Number

Name

wn

1

178B1A0401

ANNAPAREDDY BHARATHI

4~

2

178B1A0402

ATCHALA CHANDRAKALA

b
J

178B1A0403

BADUGU AKSHA TEJA

178B1A0404

BALAGANI SURYA KANTHAM

n

178B1A0405

BHUMA VENKATA SUNEETHA

th

(=%

178B1A0406

BURRA SAI LAKSHMI

wn

~

178B1A0407

CHEREDDY KALPANA

o

178B1A0408

CHINTHAPATLA PAVITHRA

178B1A0409

CHIRITOTI LAVANYA

E

10

178B1A0410

DAMA VENKATA KEERTHANA

w

11

178B1A0411

G MANISHA

12

178B1A0412

GUNAPANENI VANDANA

13

178B1A0413

GUNDLAPALLI SAMPURNA

14

178B1A0414

JONNALA GADDA ALEKYA

15

178B1A0415

JONNALAGADDA SRUTHI SRAVYA

W

178B1A0416

KADIRI DEEPTHI

17

178B1A0417

KAKARLA YAMINI

/7

|
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S.No| Roll Number Name 1 3 4 5
18 178B1A0418 |KANDEPI VENKATA SAI SRAVANI 5 4 5 4
19 178B1A0419 |KOLAPARTI BHAVYASRI 3 5 4 4
20 178B1A0420 |KOLLI MARLA SWETHA 5 5 4 5
21 178B1A0421 |[KOMATINENI MOUNIKA 3 5 5 4
22 178B1A0422 |KONIDENA MANISHA 4 5 4 5
23 178B1A0423 |LAKKU MEENAKSHI 5 4 4 5
24 178B1A0424 |LAKSHMISETTY VYSHNAV KEERTHI 5 4 5 S
25 178B1A0425 |MANNAM SRAVANI 5 4 5 S
26 178B1A0426 |[MANNEM YAMINI 5 5 4 4
27 178B1A0427 |NARISINGU VASANTHI 4 4 5 5
28 178B1A0428 [NERELLA VENKATA SUSHMA 5 4 5 5
29 178B1A0429 [NUTHALAPATI SRILATHA 5 5 5 5
30 178B1A0430 |[NUTHALAPATI THRIVENI 5 4 5 4
31 178B1A0431 |PABBISETTY SAI LAKSHMI VANDANA 4 4 5 5
39, 178B1A0432 |PABBISETTY VENKATA RAMYASRI 5 5 5 4
33 178B1A0433 |PERLA VENKATA SAI DEEPTHI 4 4 5 5
34 178B1A0434 |PURIMITLA NAGA LAKSHMI 5 4 4 5
35 178B1A0435 |RENUMALA MOUNIKA 5 4 4 5
36 178B1A0436 [SHAIK SAMINA 5 4 S 4
37 178B1A0437 |SHAIK YASMIN /—> 4 4 5 5
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S.No| Roll Number Name 1 2 3 6
38 178B1A0438 |SURA NARAYANAMMA 3 4 4 5
39 178B1A0439 |THANIKANTI HARIKA 4 4 5
40 178B1A0440 |UDARAGUDI SAILAJA 3 4 5 5
41 178B1A0441 |YARICHARLA MOUNIKA 3 5 4 5
42 178B1A0442 |ALLA ASHOKREDDY 3 4 4 5
43 178B1A0443 |ALLIKEPALI SRIKANTH 4 5 4 5
44 178B1A0444 |CHAKKA NITHISH 3 5 5 5
45 178B1A0445 |DANNARAPU PAVAN KALYAN 4 5 4 5
46 178B1A0446 |DODDI STEPHEN RAJ 4 4 4 4
47 178B1A0447 |ELURI VENKATA SANJAY 5 4 4
48 178B1A0448 |KOPPOLU RAMA KRISHNA 4 5 5 5
49 178B1A0449 |KOTA BRAHMAREDDY 4 5 5 4
50 178B1A0450 |MUVALA SAI VENKATA NAGA VINAY 4 4 5 5
51 178B1A0451 |PABBISETTY MANOJ 5 4 5 4
52 178B1A0452 |POLIMIREDDY MALAKONDA REDDY 5 4 5 4
53 178B1A0453 |PONIGETI HANUMANTHA REDDY 4 4 4 5
54 178B1A0454 |SANKARAMANCHI NAGAMANOHAR SHARMA 3 5 5 S
55 178B1A0455 |SHAIK YASDHANI 4 5 5 s
56 178B1A0456 |SIGHAKOLLI BALA SUBRAMANYAM 3 5 5 s
57 178B1A0457 |SUNDARASETTY NIKHIL 4 5 5 5

e b
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S.No| Roll Number Name 1 4 6
58 178B1A0458 |THOGURU PRAVEEN KUMAR 5 5 4
59 178B1A0459 |THOKALA SAMSON 4 4 5
60 178B1A0461 |ADAPALA ANUSHA 5 5 5
61 178B1A0462 |ALURIRAYELAMMA 4 4 5
62 178B1A0463 |BATCHALI VENKATA SAI SARATH PRATYUSHA 5 4 5
63 178B1A0464 |BIJJAM SRI LEENA 5 4 5
64 178B1A0465 |BIRUDURAJUNAVYA SUSHMA 5 5 5
65 178B1A0466 |CHINTHALA KEERTHANA 4 4 5
66 178B1A0467 |DEVULAPALLI MAHALAKSHMAMMA 5 4 5
67 178B1A0468 |DODDAKA NAGA DEEPTHI 4 4 5
68 178B1A0470 |GUJJULA MAHALAKSHMI 5 5 4
69 178B1A0471 |GUNJI ANUSHA 5 5 5
70 178B1A0472 |KALLAGUNTA VANI VARSHITHA 5 5 5
71 178B1A0473 |KARETI PRAVALLIKA 4 5 5
72 178B1A0474 |KATTA HYNDAVI 5 5 5
73 178B1A0475 |KELAM RAMA DEVI 5 4 5
74 178B1A0476 |MADALA VENKATA SAl LAKSHMI 5 5 5
75 178B1A0477 |MARELLA VENKATA SIREESHA 5 5 4
76 178B1A0478 |MOLAKALAPALLI MADHAVILATHA 4 5 5
77 178B1A0479 |MONDRU MARY AMULYA D) 5 5




S.No| Roll Number Name 1 2 4 5 6
78 178B1A0480 |MOTHUKURI ANILA 5 4 5 5 4
79 178B1A0482 [NELAMALLI SUREKHA 5 5 5 5 5
80 178B1A0483 |NUKATHOTI DEENAMMA 5 5 5 4 5
81 178B1A0484 |PATHAKAMURI VIJAYA NAGA DURGA 5 5 5 5 5
82 178B1A0485 |PATHI TULASI REDDY 5 5 5 4 5
83 178B1A0486 |PATIBANDLA SIREESHA 5 5 4 4 4
84 178B1A0487 |PITTU PAVAN KALYANIREDDY 5 5 4 4 5
85 178B1A0488 |POTHUGANTI CHINNA SIDDAMMA 4 5 5 5 5
86 178B1A0489 |RAMIREDDY PRAVALLIKA 4 5 5 4 4
87 178B1A0490 [RAVELLA APARNA 5 5 5 5 5
88 178B1A0491 |SALAVA POOJA 5 5 5 5 5
89 178B1A0492 |SHAIK KARISHMA 5 5 4 5 5
90 178B1A0493 |SURA KUSUMALATHA 5 4 5 5 5
91 178B1A0494 [SYED MEHASEENA 5 4 5 5 4
92 178B1A0495 |THANNEERU ROSHINI RUPA 5 5 4 5 S
93 178B1A0496 |VEERANKI TEJASWI 5 4 5 4 4
94 178B1A0497 |AKKALA PRAVEEN KUMAR REDDY 4 5 5 4 5
95 178B1A0498 |BATTULA PRADEEP CHANDRA 4 4 5 5 5
96 178B1A0499 |BEERALA RAM PAVAN KALYAN S 4 5 4 4
97 178B1A04A0 |CHITTELA HEMANTH KUMAR /"’_:— ! 4 4 5 5
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S.No| Roll Number Name 1 2 3 4 5 6
98 178B1A04A1 {DAMA RAMA KRISHNA 5 4 5 5 4 S
99 | 178B1A04A3 [JALADANKIJAYAPRAKASHNARAYANA 5 5 4 5 4
100 | 178B1A04A4 |KALAVAKURI SIVAKRISHNA 3 4 4 5 5 5
101 178B1A04A5 |KOLISETTY MALLIKARJUNA 5 5 5 5 5 5
102 | 178B1A04A6 |KOLLURIRAJA SHEKAR 5 4 5 4 5 4
103 | 178B1A04A7 |KONKA VENKATA JAGADEESH BABU 5 5 5 5 4 5
104 | 178B1A04B0 |NUKALAPATI CHANDRA SEKHAR 4 4 5 5 5 5
105 | 178B1A04B2 |[PARUCHURI GOPI 5 5 4 4 4 4
106 | 178B1A04B4 |SHAIK BAIJI 5 S 5 4 5 5
107 178B1A04B5 |TANNERU MAHESH 4 5 4 5 5 5
108 178B1A04B6 |TELLAMEKALA RAJA HANUMA 5 4 S 5 S 5
109 | 178B1A04B7 [THUMMALA VISHNU 5 5 5 5 5 5
110 178B1A04B8 |UDDAGIRI NAVEEN 4 5 4 5 5 4
111 178B1A04B9 |YESUPOGU VIJAY 4 4 5 4 5) 5
471 | 463 | 463 | 463 | 4.88 4.75
94.29| 92.50 | 92.50 | 92.50] 97.50 | 95.00
i {Jg@\w: M
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Topic

Resource Person

Dates
Venue

Targeted Students

: Dr.P.Surendra Kumar,

Certificate program Feedback Analysis

. Certification program on” Antenna Design using HFSS”

Associate Professor, Bapatla Engineering College, Bapatla.

: 02-02-2021 to 06-02-2021
: MPMC Lab
. IV Year students

S.No

No. of students
Participated

No. of students
given feedback

Feedback %

111

111

100%

Coordjnator

GROUP OF I
VALLURU:
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Department of ECE
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#5s. RISE KRISHNA SAT GANDHI GROUP OF INSTITUTIONS

(Approved by AICTE,New Delhi & Affiliated to INTUK;Kakinada)
NH-16, Valluru, Ongole, Prakasam (District)-523272
Department of Electronics and Communication Engineering

Certificate Program on Antenna Design using HFSS
Model Question Paper

Branch/Sem: IV ECE/l SEM

Name of the Student: ROLL Number:

1. HFSS is a software tool used for simulations.
a) Mechanical

b) Electromagnetic

¢) Thermal

d) Fluid dynamics

2. The acronym HFSS stands for

a) High-Frequency Signal Simulation

b) High-Fidelity Structure Solver

¢) Iligh-Frcquency Structure Simulator

d) High-Field Simulation Software

3. HFSS is commonly used for designing and simulating

a) Antennas

b) Bridges

c) Buildings

d) Automobiles

4. In HFSS, the unit of frequency is typically expressed in
a) Hertz (Hz)

b) Watts (W)

¢) Newtons (N)

d) Volts (V)

(Gt
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Department of Electronics and Communication Engineering

5. The most common type of antenna simulated using HFSS is the antenna.
a) Yagi-Uda [1]

b) Patch

c) Dipole

d) Log-periodic

6. HFSS uses the method for solving Maxwell's equations. [ ]
a) Finite Difference Time Domain (FDTD)

b) Method of Moments (MoM)

c) Finite Element Method (FEM)

d) Finite Integration Technique (FIT)

7. What does the acronym MoM stand for in the context of electromagnetic simulations?
a) Method of Moments [1
b) Moments of Magnitude

¢) Moments of Motion

d) Method of Magnetics

8. HFSS can analyze antennas operating in different frequency domains, including | ]
a) DC (Direct Current)

b) RF (Radio Frequency)

¢) Optical

d) All of the above

9. The term "meshing" in HFSS refers to the process of dividing the geometry into [ 1]
a) Materials

b) Domains

c) Mesh elements
(Caolsr
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(Approved by AICTE,New Delhi & Affiliated to INTUK Kakinada)
NH-16, Valluru, Ongole, Prakasam (District)-523272
Department of Electronics and Communication Engineering

d) Layers

10. HFSS can simulate both and antennas. [ 1

a) Active, Passive

b) Linear, Non-linear

c¢) Planar, Non-planar

d) Omni-directional, Directional

11. The S-parameter that represents the power reflected back from an antenna is

a) S11 [1]
b) S21

c)S12

d) S22

12, The characteristic impedance of a transmission line is represented by the
paramctcr. [ 1

a) Z11
b) Z21
c) Z12
d) 222

13. HFSS can simulate the radiation pattern of an antenna, which describes its

[]

a) Frequency response
b) Gain
c) Spatial distribution of radiation

d) Polarization

acoer
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Department of Electronics and Communication Engineering

14. The "far-field" region of an antenna is also known as the region. [ ]
a) Reactive

b) Near-field

c) Intermediate

d) Radiative

15. The radiation efficiency of an antenna is a measure of : [ 1]
a) How well it radiates

b) How well it receives signals

c) The losses in the antenna system

d) The bandwidth of the antenna

16. HFSS can simulate the coupling between different antennas in an array using

analysis. [ 1]
a) Near-field
b) Far-field
c) Mutual
d) Self
17. The term "substrate" in the context of antenna design refers to . [

a) The conductive material of the antenna

b) The dielectric material on which the antenna is mounted

¢) The length of the antenna elements

d) The frequency of operation

18. HFSS can analyze the effect of on antenna performance. []
a) Temperature

b) Humidity

¢) Wind speed h @5 S‘)
=
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Department of Electronics and Communication Engineering

d) All of the above

19. The design of a microstrip patch antenna involves specifying the dimensions of the

[ ]

a) Ground plane

b) Substrate

c) Patch

d) All of the above

20. The term "gain" in antenna design refers to ; [ ]
a) The ability of an antenna to concentrate radiation in a particular direction

b) The total power radiated by the antenna

c) The frequency response of the antenna

d) The impedance matching of the antenna
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ANSWERS

1.Answer: Electromagnetic

2.Answer: High-Frequency Structure Simulator

3.Answer: Antennas

4.Answer: Hertz (Hz)

5.Answer: Patch

6.Answer: Finite Element Method (FEM)
7.Answer: Method of Moments

8.Answer: All of the above

9.Answer: Mesh elements

10.Answer: Planar, Non-planar

11.Answer: S11

12.Answer: Z11

13.Answer: Spatial distribution of radiation
14.Answer: Radiative

15.Answer: How well it radiates
16.Answer: Mutual

17.Answer: The dielectric material on which the antenna is mounted
18.Answer: Temperature

19.Answer: All of the above

20.Answer: The ability of an antenna to concentrate radiation in a particular direction
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Certificate Program on Antenna Design using HFSS ‘ q
Model Question Paper /
Branch/Sem: IV ECE/l SEM O/D -
Name of the Student: gpf)umal o MOUNMKQ ROLL Number: 3 3 35
1. HFSS is a software tool used for simulations. .[b]/
a) Mechanical

b) Electromagnetic

¢) Thermal

d) Fluid dynamics

2. The acronym HFSS stands for A [c]

a) High-Frequency Signal Simulation L/

b) High-Fidelity Structure Solver

¢) High-Frequency Structure Simulator

d) High-Field Simulation Software

3. HFSS is commonly used for designing and simulating [c‘y-
a) Antennas

b) Bridges

¢) Buildings

d) Automobiles

4. In HFSS, the unit of frequency is typically expressed in ‘[9]/
a) Hertz (Hz)

b) Watts (W)

c¢) Newtons (N)

d) Volts (V)
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5. The most common type of antenna simulated using HFSS is the antenna.
a) Yagi-Uda ‘[b]/

b) Patch

c) Dipole

d) Log-periodic

6. HFSS uses the method for solving Maxwell's equations. [9/

a) Finite Difference Time Domain (FDTD)

b) Method of Moments (MoM)

¢) Finite Element Method (FEM)

d) Finite Integration Technique (FIT)

7. What does the acronym MoM stand for in the context of electromagnetic simulations?
a) Method of Moments .B']/
b) Moments of Magnitude I

¢) Moments of Motion

d) Method of Magnetics

8. HFSS can analyze antennas operating in different frequency domains, including [ ]_
a) DC (Direct Current) s
b) RF (Radio Frequency)

¢) Optical

d) All of the above

9. The term "meshing" in HFSS refers to the process of dividing the geometry into [C]
a) Materials

b) Domains

¢) Mesh elements

AL
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d) Layers

10. HFSS can simulate both and antennas. Ic]

a) Active, Passive

b) Linear, Non-linear

c) Planar, Non-planar

d) Omni-directional, Directional

11. The S-parameter that represents the power reflected back from an antenna is
a) S11 [b}y
b) S21 j

c) S12

d) S22

12. The characteristic impedance of a transmission line is represented by the
parameter. @)

a) Z11 /
b) Z21
c)Z12
d) 222

13. HFSS can simulate the radiation pattern of an antenna, which describes its

a) Frequency response
b) Gain
¢) Spatial distribution of radiation

d) Polarization
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14. The "far-field" region of an antenna is also known as the region. j0\]
a) Reactive /
b) Near-field

¢) Intermediate

d) Radiative

15. The radiation efficiency of an antenna is a measure of . [a]
a) How well it radiates

b) How well it receives signals

c) The losses in the antenna system

d) The bandwidth of the antenna

16. HFSS can simulate the coupling between different antennas in an array using
analysis. [c]

A

a) Near-field

b) Far-field

¢) Mutual

d) Self

17. The term "substrate’ in the context of antenna design refers to [ %]/‘
a) The conductive material of the antenna

b) The dielectric material on which the antenna is mounted

¢) The length of the antenna elements

d) The frequency of operation

18. HFSS can analyze the effect of on antenna performance. y/
a) Temperature

b) Humidity

¢) Wind speed
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d) All of the above

19. The design of a microstrip patch antenna involves specifying the dimensions of the

_@’

a) Ground plane

b) Substrate

c) Patch

d) All of the above

20. The term "gain'' in antenna design refers to 5 9/‘
a) The ability of an antenna to concentrate radiation in a particular direction

b) The total power radiated by the antenna

¢) The frequency response of the antenna

d) The impedance matching of the antenna
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1. HESS is a software tool used for simulations. ] [AV

a) Mechanical

b) Electromagnetic

¢) Thermal

d) Fluid dynamics

2. The acronym HFSS stands for 5 [Al
a) High-Frequency Signal Simulation

b) High-Fidelity Structure Solver

¢) [igh-Frequency Structure Simulator

d) High-Field Simulation Software

3. HFSS is commonly used for designing and simulating [N
a) Antennas

b) Bridges

¢) Buildings

d) Automobiles

4. In HFSS, the unit of frequency is typically expressed in '%.}
a) Hertz (Hz)

b) Watts (W)

c) Neﬁons M)

d) Volts (V)
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5. The most common type of antenna simulated using HFSS is the antenna.
a) Yagi-Uda [ &/
b) Patch |

c) Dipole

d) Log-periodic

6. HFSS uses the method for solving Maxwell's equations. [/C} =
a) Finite Difference Time Domain (FDTD)

b) Method of Moments (MoM)

¢) Finite Element Method (FEM)

d) Finite Integration Technique (FIT)

7 What does the acronym MoM stand for in the context of electromagnetic simulations?
a) Method of Moments 1Al

b) Moments of Magnitude o

¢) Moments of Motion

d) Method of Magnetics

8. HFSS can analyze antennas operating in different frequency domains, including/[{}}'

a) DC (Direct Current)

b) RF (Radio Frequency)

c) Optical

d) All of the above

9. The term "meshing" in HFSS refers to the process of dividing the geometry int(-)/[,@_’
a) Materials

b) Domains

c) Mesh elements

RI

GR
VA



@ RISE KRISHNA SAI GANDHI GROUP OF INSTITUTIONS
3 (Approved by AICTE New Delhi & Affiliated to JNTUK Kakinada)
NH-16, Valluru, Ongole, Prakasam (District)-523272
Department of Electronics and Communication Engineering

d) Layers

10. HFSS can simulate both and antennas. y

a) Active, Passive

b) Linear, Non-linear

c) Planar, Non-planar

d) Omni-directional, Directional

11. The S-parameter that represents the power reflected back from an antenna is

a) S11

rAgs
/
b) S21

¢) S12

d) §22

12. The characteristic impedance of a transmission line is represented by the

paramcter. ‘[9,/

a)Z11

b) 221

c)Z12

d) 722

13. HFSS can simulate the radiation pattern of an antenna, which describes its .
y

a) Frequency response

b) Gain

c) Spatial distribution of radiation

d) Polarization
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14. The "far-field" region of an antenna is also known as the region. [A]

; (v
a) Reactive

b) Near-field

¢) Intermediate

d) Radiative

15. The radiation efficiency of an antenna is a measure of %
a) How well it radiates -

b) How well it receives signals

c) The losses in the antenna system

d) The bandwidth of the antenna

16. HFSS can simulate the coupling between different antennas in an array using

analysis. /1A
a) Near-field
b) Far-field
c¢) Mutual
d) Sclf
17. The term "substrate" in the context of antenna design refers to . %/

a) The conductive material of the antenna
b) The dielectric material on which the antenna is mounted
c) The length of the antenna elements

d) The frequency of operation

18. HFSS can analyze the effect of on antenna performance. /48
a) Temperature 4

b) Humidity

¢) Wind speed
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d) All of the above

19. The design of a microstrip patch antenna involves specifying the dimensions of the

"I

a) Ground plane

b) Substrate

c) Patch

d) All of the above

20. The term "gain" in antenna design refers to : y/
a) The ability of an antenna to concentrate radiation in a particular direction

b) The total power radiated by the antenna

¢) The frequency response of the antenna

d) The impedance matching of the antenna
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Certification Program Report on

“Antenna Design using HFSS”

Date: 02nd to 06th February 2021

Introduction:

The Antenna Design using HFSS Certification Program, held from February 2nd to February 6th, 2021, was
organized under the visionary leadership of the Head of the Department, Mr. S.V. Ravi Kumar. The program
aimed to provide participants with an in-depth understanding of antenna design principles and hands-on
experience with thc High-Frequency Structure Simulator (HFSS) software. Dr. K.V. Subrahmanyam, our
esteemed Principal, and Dr. P. Surendra Kumar, a distinguished resource person, played pivotal roles in

ensuring the success of this educational endeavor.

Syllabus covered:

1. Introduction to Antennas: The program commenced under the guidance of Dr. P. Surendra Kumar, whose

leadership set the tone for an exploration of fundamental antenna concepts. Participants delved into the
historical development of antennas, their role in communication systems, and various antenna
types.Antennas are fundamental components in the field of electromagnetic communication, serving as the
bridge between electronic devices and the surrounding electromagnetic environment. These devices play a
pivotal role in transmitting and receiving electromagnetic waves, enabling wireless communication across a
myriad of applications such as radio and television broadcasting, mobile communication, radar systems,
satellite communication, and more.
Historical Evolution: The history of antennas traces back to the late 19th century, coinciding with the
groundbreaking work of pioneers such as Heinrich Hertz and Guglielmo Marconi. Hertz's experiments with
radio waves and Marconi's subsequent development of practical wireless communication marked the advent
of antenna technology. Since then, antennas have evolved significantly, driven by technological
advancements and the ever-expanding demands of modern communication systems.

Basic Concepts: At its core, an antenna is a transducer that converts electrical signals into electromagnetic

waves for transmission or vice versa for reception. This procgsS involves yulanon of electric and
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magnetic fields to generate a propagaling electivmagnetic wave. Key parameters such as frequency, gain,

polarization, and radiation pattern define the performance characteristics of an antenna.

a. Types of Antennas: Antennas come in various forms, each tailored to specific applications and
operating principles. Common types include dipole antennas, monopole antennas, patch
antennas, yagi-uda antennas, and parabolic antennas. The selection of an antenna type depends
on factors such as frequency range, directional requirements, and the overall communication
system's design goals.

b. Role in Communication Systems: In communication systems, antennas serve as the interface
between electronic circuits and the surrounding electromagnetic field. In transmission, an
electrical signal is applied to the antenna, converting it into an electromagnetic wave that
propagates through space to reach the intended receiver. In reception, the antenna captures
incoming electromagnetic waves, converting them back into electrical signals for further
processing.

c. Parameters and Characteristics: Understanding and optimizing antenna parameters are
essential for efficient communication systcm dcsign. Parameters such as impedance, bandwidth,
radiation pattern, and efficiency influence an antenna's performance. Engineers and designers
carefully consider these factors to achieve desired outcomes in terms of signal coverage, range,
and reliability.

d. Technological Advancements: Advancements in materials, design techniques, and
computational tools have significantly contributed to the evolution of antenna technology.
Computer-aided design (CAD) software, electromagnetic simulation tools, and advanced
manufacturing processes have empowered engineers to create antennas with enhanced
performance and reduced size, pushing the boundaries of what is achievable in modern
communication systems.

e. Future Trends: The evolution of antennas continues as we enter an era of pervasive
connectivity and the Internet of Things (loT). Miniaturization, multi-functionality, and
adaptability are becoming increasingly important. Antennas are expected to play a crucial role in
the development of 5G networks, smart cities, and emerging technologies, further shaping the
landscape of wireless communication.

2. Antenna Architecture: Antenna architecture encompasses the structural design and configuration of
antennas, defining their physical layout and arrangement of elements to achieve specific performance
goals. The choice of architecture is crucial as it directly influences the antenna's characteristics,
including gain, directivity, bandwidth, and radiation pattern. 1 e delve into various

ide their design. AL
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Dipole Antennas: Dipole antennas are one of the simplest and most widely used antenna
architectures. They consist of a conductive element, typically a straight wire or pair of wires,
with a voltage source applied across its ends. Dipole antennas radiate energy in a symmetric

pattern and are commonly used in radio and television broadcasting due to their omnidirectional

characteristics.

\“N Electromagnetic Wave

Radio Receiver
Monopole Antennas: A monopole antenna is a single, straight conductor mounted over a

ground plane. It is a half-wave dipole with one-half of the dipole element replaced by a ground
plane. Monopole antennas are extensively used in mobile communication devices, where their
compact size and omnidirectional radiation pattern make them suitable for various applications.
Patch Antennas: Patch antennas, also known as microstrip antennas, consist of a flat, metallic
patch mounted above a ground plane. They find widespread use in communication systems due
to their low profile, ease of integration, and suitability for planar and conformal applications.
Patch antennas are commonly employed in wireless communication systems, RFID, and satellite
communication.

Yagi-Uda Antennas: Yagi-Uda antennas are directional antennas consisting of multiple parallel
elements, including one driven element, a reflector, and one or more directors. This architecture
provides high gain and directivity, making Yagi-Uda antennas suitable for point-to-point
communication, such as in television reception and amateur radio.

Parabolic Antennas: Parabolic antennas utilize a parabolic reflector to focus incoming or
outgoing electromagnetic waves. The feed antenna, often located at the reflector’s focal point,
provides a highly directional beam. Parabolic antennas are widely used in satellite
communication, radar systems, and point-to-point microwave links, where high gain and narrow

beamwidth are critical.

Horn Antennas: Horn antennas feature a flared opeps gradual transition

between the transmission line and free space. They /wtheir wide bandwidth
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and moderate gain. Horn antennas are employed in radar systems, satellite communication, and
microwave applications, where a balanced compromise between gain and bandwidth is required.
Log-Periodic Antennas: Log-periodic antennas consist of multiple dipole elements arranged in
a geometric pattern that repeats logarithmically. This architecture provides consistent
performance over a broad frequency range, making log-periodic antennas suitable for
applications requiring wideband coverage, such as in television broadcasting and

communication systems.

3. Considerations in Antenna Architecture:

a.

Frequency Range: The chosen architecture should be suitable for the frequency range of
interest.

Gain and Directivity: Different architectures offer varying levels of gain and directivity,
influencing the coverage and reach of the antenna.

Size and Form Factor: The physical size and form factor of antenna architecture are critical
considerations, especially in space-constrained environments.

Polarization: The desired polarization (e.g., vertical, horizontal) for communication needs
guides the selection of antenna architecture.

Environmental Factors: Considerations such as wind loading, temperature, and environmental

conditions impact the choice of antenna architecture.

As technology continues to advance, antenna architectures evolve to meet the demands of emerging

applications. The selection of the most suitable architecture involves a careful balance of

performance requirements, environmental considerations, and the specific needs of the

communication system in which the antenna is deployed.

4. Introduction to HFSS:

HFSS, or High-Frequency Structure Simulator, is powerful and versatile electromagnetic simulation

software developed by Ansys, Inc. It is widely used in the field of radio frequency (RF), microwave,

and high-speed digital design for simulating and analyzing electromagnetic fields. HFSS provides

engineers and designers with a comprehensive platform to model, simulate, and optimize complex

electromagnetic systems, including antennas, RF/microwave components, and integrated circuits.

5. Key Features and Capabilities:

a.

Full-wave Electromagnetic Simulation: HFSS employs a full-wave simulation approach,

solving Maxwell's equations to accurately model the behavior of electromagnetic fields in

complex structures. This capability allows for a detailed
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b. Broad Frequency Range: One of HFSS's strengths lies in its ability to handle a broad
frequency range, spanning from radio frequencies (RF) to microwave and millimeter-wave
frequencies. This makes it suitable for the design and analysis of a wide range of devices,
including antennas, filters, transmission lines, and resonators.

¢. Parametric Analysis and Optimization: Engineers can perform parametric analysis and
optimization studies using HFSS. This functionality enables the exploration of design variations
and the optimization of parameters to achieve specific performance goals. It is particularly
useful for tuning antenna designs, matching network optimization, and fine-tuning
RF/microwave circuits.

d. Integration with CAD: HFSS seamlessly integrates with computer-aided design (CAD) tools,
allowing users to import complex 3D geometries and structures. This integration streamlines the
design workflow, making it easier for engineers to create accurate models and simulate realistic
scenarios.

e. Antenna Design and Analysis: HFSS is widely recognized for its capabilities in antenna design
and analysis. Engineers can simulate various types of antennas, including wire antennas, patch
antennas, and reflector antennas, among others. The software provides insights into parameters
such as radiation patterns, gain, impedance matching, and efficiency.

f. High-Frequency Component Simulation: HFSS is instrumental in the simulation of high-
frequency components such as filters, couplers, and resonators. Engineers can analyze the
performance of these components in different frequency bands, taking into account the effects of
electromagnetic coupling, signal integrity, and impedance matching.

g. Finite Element Method (FEM) Solver: The software employs the finite element method
(FEM) as its underlying numerical technique for solving Maxwell's equations. This method
enables accurate modeling of complex geometries and material properties, making HFSS
suitable for a wide range of applications in electromagnetics.

h. Transient and Frequency-Domain Analysis: HFSS supports transient and frequency-domain
analyses, allowing engineers to study the time-dependent behavior of electromagnetic fields and
analyze frequency responses. This versatility is beneficial in understanding dynamic behaviors
and optimizing designs for various operational conditions.

6. Applications of HFSS:
a. Wireless Communication Systems: HFSS is widely used in the design and optimization of

antennas for wireless communication systems, including stations, and

satellite communication.
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b. RF and Microwave Circuits: Engineers leverage HFSS to simulate and optimize RF and
microwave circuits, such as filters, amplifiers, and matching networks, ensuring optimal
performance and reliability.

c. Radar Systems: HFSS plays a crucial role in the design and analysis of radar systems,
including the antennas and components used in radar transmitters and receivers.

d. Integrated Circuits (ICs): For high-speed digital design, HFSS aids in the simulation of signal
integrity, crosstalk, and electromagnetic interference in integrated circuits, ensuring robust
performance.

e. Medical Devices: In the medical field, HFSS is applied to model and analyze electromagnetic
interactions in devices such as MRI coils and biomedical sensors.HFSS is a comprehensive
electromagnetic simulation tool that empowers engineers to design and optimize high-frequency
components with confidence and precision. Its versatile features and broad application spectrum
make it an indispensable tool in industries ranging from telecommunications to aerospace and
beyond.

7. Antenna Parameters: Antennas are essential components in the field of wireless communication,
serving as the interface between electronic devices and the surrounding electromagnetic environment.
The performance of an antenna is characterized by various parameters that define its behavior and
effectiveness in transmitting or receiving electromagnetic waves. Understanding these parameters is
crucial for antenna design, optimization, and integration into communication systems. Here, we explore
key antenna parameters and their significance:

a. Radiation Pattern:

Definition: The radiation pattern of an antenna describes the distribution of radiated
electromagnetic energy in space.

Significance: It provides insights into how an antenna focuses or spreads its energy in different
directions. Common patterns include omnidirectional, directional, and sectorial, influencing
coverage and signal strength.

b. Gain:

Definition: Antenna gain measures the ability of an antenna to direct or concentrate radiated
power in a specific direction.
Significance: A higher gain indicates increased directional focus, enabling longer

communication range or improved signal strength in a particular direction. However, gain is
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often a trade-off with beam width and coverage.



Directivity:

Definition: Directivity represents the concentration of radiated power in a particular direction,
often compared to an isotropic radiator (perfectly omnidirectional).

Significance: High directivity indicates a more focused radiation pattern, contributing to
increased gain in the desired direction.

Beam width:

Definition: Beam width is the angular width of the main lobe in the radiation pattern, measured
between points where the power is half the maximum.

Significance: Narrow beam width enhances directionality but may limit coverage. Broad beam
width is beneficial for omnidirectional coverage.

Polarization:

Definition: Polarization refers to the orientation of the electric field in the electromagnetic wave
radiated by the antenna.

Significance: Proper polarization alignment between transmitting and receiving antennas is

essential for efficient signal coupling. Common polarizations include vertical, horizontal, and

circular.

Impedance:

Definition: Antenna impedance represents the opposition to the flow of alternating current in
the antenna.

Significance: Matching antenna impcdance with the transmission line or system impedance is
critical for minimizing signal reflections and maximizing power transfer

Bandwidth:

Definition: Bandwidth refers to the range of frequencies over which the antenna can operate
effectively, often defined by the frequency range where the gain falls within a specified
threshold.

Significance: A broader bandwidth allows the antenna to support a wider range of frequencies,
making it versatile in diverse communication environments.

Efficiency:

Definition: Efficiency quantifies how effectively the antenna converts input power into radiated
electromagnetic waves.

Significance: High efficiency ensures that a significant portion of the input power contributes to
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useful radiation, minimizing power losses.
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i. VSWR (Voltage Standing Wave Ratio):

Definition: VSWR measures the ratio of the maximum voltage to the minimum voltage in a
standing wave pattern along the transmission line.

Significance: A low VSWR indicates good impedance matching and minimal signal reflection,
optimizing power transfer.

j. Resonant Frequency:

Definition: Resonant frequency is the frequency at which an antenna exhibits maximum
efficiency and performance.

Significance: Operating an antenna at its resonant frequency enhances its effectiveness and
ensures optimal performance in a specific frequency band.

k. Front-to-Back Ratio:

Definition: The front-to-back ratio measures the relative strength of the radiation pattern in the
forward direction compared to the backward direction.
Significance: A higher front-to-back ratio is desirable for directional antennas, minimizing
interference from signals arriving from the rear.
Importance of HFSS with other Tools:
HFSS, as a high-fidelity electromagnetic simulation tool, plays a pivotal rolc in the design and analysis
of antennas, RI/microwave componcnts, and other high-frequency structures. While HFSS is a
powerful standalone tool, its integration with other simulation and design tools enhances the overall
engineering workflow, providing a more comprehensive approach to solving complex electromagnetic
problems. Here's an exploration of the importance of HFSS in conjunction with other tools:
Comprehensive Simulation Capabilities:

a. HFSS Strengths: HFSS excels in full-wave electromagnetic simulations, accurately capturing
complex electromagnetic phenomena.

b. Complementary Tools: Coupling HFSS with tools for structural, thermal, or fluid dynamics
simulations allows for comprehensive multi-physics analysis, ensuring a more realistic
representation of real-world scenarios.

Antenna Designing Mathematical Calculations: Dr. P. Surendra Kumar led participants through the
mathematical foundations of antenna design, including formulas for impedance matching, gain
calculations, and directivity. Real-world applications and case studies illustrated the practical

significance of mathematical calculations in the design process.
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11. Antenna Designing Procedures:

Antenna design with HFSS involves leveraging the software's capabilities for electromagnetic

simulation and optimization. Here's a step-by-step procedure for designing an antenna using HFSS:

a.

Define Design Requirements:

Clearly specify the purpose of the antenna (e.g., communication, radar, satellite).Identify key
specifications such as frequency range, gain, radiation pattern, and polarization.

Research and Choose Antenna Type:

Explore different antenna types suitable for the application. Use HFSS's knowledge base and
documentation to understand the strengths and limitations of various antenna types. Choose an
antenna type based on the research and requirements.

HEFSS Project Setup:

Launch HFSS and set up a new project.Define project unit, frequency range, and other
simulation settings.

Geometry and Dimensions:

Create the 3D geometry of the antenna using HFSS's modeling tools. Input the calculated
dimensions based on the chosen antenna type and operating frequency.

Excitation and Boundary Conditions:

Define the feeding mechanism (e.g., port, waveguide) using HFSS's excitation features.Apply
appropriate boundary conditions to simulate the antenna's interaction with its surroundings.
Material Assignment:

Assign material properties to the antenna structure using HFSS's material library.Choose
materials based on their electromagnetic characteristics and environmental considerations.
Meshing:

Generate a mesh for the antenna geometry using HFSS's meshing tools. Adjust mesh parameters
to ensure accuracy and efficiency in the simulation.

Simulation:

Run a simulation to analyze the antenna's electromagnetic behavior. Examine key parameters
such as S-parameters, radiation pattern, gain, and impedance matching.

Optimization:

Utilize HFSS's optimization tools to improve antenna performance. Perform parametric sweeps
or use optimization algorithms to adjust antenna parameters for optimal results.Iteratively

simulate and optimize until the desired performance is achieve
L
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Post-Processing and Visualization:

Analyze simulation results using HFSS's post-processing tools. Visualize radiation patterns, far-
field plots, and other relevant data. Evaluate performance metrics and compare with design
requirements.

Fabrication and Prototyping:

Use the optimized design parameters to fabricate a physical prototype. Verify dimensions and
configurations against the simulation results.

Validation and Testing:

Set up a testing environment consistent with real-world conditions. Measure key parameters
using testing equipment such as network analyzers and spectrum analyzers.Validate the

prototype's performance against simulation results.

. Fine-Tuning and Adjustment:

If necessary, make adjustments to the antenna based on testing results.Iterate between
simulation, fabrication, and testing to refine the design.

Documentation:

Document the final antenna design, including specifications, simulation results, and testing
outcomes. Create a comprehensive report that can be shared with stakeholders

Integration into System:

Integrate the designed antenna into the larger communication or electronic system. Verify
compatibility and performance in the system environment.

Field Deployment:

Conduct field tests to validate the antenna's performance in real-world conditions. Gather
feedback and make any necessary adjustments or improvements.

Maintenance and Optimization:

Develop a plan for long-term maintenance and potential future optimizations. Establish a
feedback loop for continuous improvement based on field performance and user feedback.By
following this comprehensive procedure, engineers can leverage HFSS's powerful simulation
and optimization capabilities to design antennas that meet or exceed performance requirements.
The iterative nature of the process, combined with the simulation tools provided by HFSS,

allows for efficient and effective antenna development.
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12. Sample Antenna Design in HFSS:
Design Procedure using HFSS software:

a. Start ANSYS Electronics Desktop. Check (and change if necessary) that the working mode i

Driven Modal, HFSS > Solution Type > Modal.

b. Set Modeler length units to mm, Modeler > Units > mm.

c. Todraw a dipole element, select Draw > Cylinder and enter calculated values at radius and
height position
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d. After drawing the first element of the dipole we will create the second one by symmetry.
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e. Select the first cylinder and then select Edit > Duplicate > Around Axis, choose the axis X
or Y and enter the angle of 180°, Total number 2.

f. To provide an input source to perform the simulation. Sale gle-and draw
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arectangle (! it’s a surface model not a volume one) between the two wires, as in the figures

below.
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g. Select the drawn rectangle and define it as the input signal area/port HFSS > Excitations >

Assign > Lumped Port.
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h. Select HFSS > Model > Create Open Region. Choose the frequency of
interest (around 900 MHz) and Radiation boundary.
i. Add asolution. Select HFSS > Analysis Setup > Add Solution Setup
j. After meshing, we define a broadband analysis. Select the previously
defined solution (Project Manager > Analysis > Setupl) and add a
broadband solution around the frequency corresponding to the single
frequency solution HFSS > Analysis Setup > Add Frequency Sweep.
k. Select HFSS > Validation Check to verify that all required steps have been
completed.
. Select HFSS > Analyze All to start the simulation. Click the Show Progress
button to view the progress of the solver.
m. Select HFSS > Results > Create Modal Solution Data Report > Rectangular
Plot to display the S parameter corresponding to input port P1 (in dB).
n. Similarly plot far-fields parameters of the antenna.
Dr. P. Surendra Kumar demonstrated the practical application of knowledge through a sample
antenna design using HFSS. Participants engaged in hands-on exercises, applying concepts
learned during the program. The Q&A session facilitated direct interaction, allowing participants
to seek clarification on specific design aspects.
Result Analysis: The critical aspect of interpreting simulation results. Participants acquired the
skills to analyze and compare simulated results with theoretical expectations. lterative design
refinement based on result analysis was emphasized.
Certificate Program Exam: The program concluded with a comprehensive exam under the
guidance of Mr. S.V. Ravi Kumar. The exam evaluated participants on theoretical knowledge
and practical skills, covering topics from the entire program. The assessment aimed to certify
participants based on their understanding and application of the concepts learned.
Vote of Thanks: We extend our sincere gratitude to Mr. S.V. Ravi Kumar, Head of the
Department, for his visionary leadership, Dr. K.V. Subrahmanyam, Principal, for his unwavering
support, and Dr. P. Surendra Kumar, the esteemed resource person, for their invaluable
contributions to the success of the Antenna Design using HFSS Certification Program. Your

guidance and mentorship have been instrumental in shaping the learning experience for all
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Date: 06-02-2021.

CLOSING REPORT

To,
The Principal,
RISE Krishna Sai Gandhi Group of Institutions.

As per the approved schedule, the ECE department has conducted a Certificate Program on
“Antenna Design using HFSS” at ECE Seminar hall from 02-02-2021 to 06-02-2021. 111
students of IV ECE have participated in this program. Dr.P.Surendra Kumar,Associate Professor,
Bapatla Engineering College, Bapatla, A.P. acted as the resource person for this program.

Main issues addressed:
1. Introduction to Anlenna.

2. Antenna Design

3. Antenna Architecture

4. Introduction to HFSS

5. Antenna Design using HFSS and Result Analysis

We are expecting your support in future also. Thanking you sir,
Yours faithfully,
S' f\/ . Vav i % % J:(“:’E
Coorflinator (9)))
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